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Legal Notices 
SUSE LLC., makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of 
merchantability or fitness for any particular purpose. Further, SUSE LLC., reserves the right to 
revise this publication and to make changes to its content, at any time, without obligation to 
notify any person or entity of such revisions or changes. 

Further, SUSE LLC., makes no representations or warranties with respect to any software, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, SUSE LLC., reserves the right to make changes to any and all parts 
of SUSE software, at any time, without any obligation to notify any person or entity of such 
changes. 

Any products or technical information provided under this Agreement may be subject to U.S. 
export controls and the trade laws of other countries. You agree to comply with all export 
control regulations and to obtain any required licenses or classification to export, re-export, 
or import deliverables. You agree not to export or re-export to entities on the current U.S. 
export exclusion lists or to any embargoed or terrorist countries as specified in the U.S. Export 
laws. You agree to not use deliverables for prohibited nuclear, missile, or chemical biological 
weaponry end uses. Please refer to https://www.suse.com/company/legal/ for more 
information on exporting SUSE software. SUSE assumes no responsibility for your failure to 
obtain any necessary export approvals. 

All files provided in this release are subject to the License Agreement, which can be found in 
the license.txt file provided in the System Certification Test Kit download. 

SUSE LLC., has intellectual property rights relating to technology embodied in the product that 
is described in this document. In particular, and without limitation, these intellectual property 
rights may include one or more of the U.S. patents listed at 
http://www.suse.com/company/legal and one or more additional patents or pending patent 
applications in the U.S. and in other countries. 

Copyright © 2018 – 2024 SUSE LLC and contributors. All rights reserved SUSE LLC. 

Publication Date:  January 2024 

SUSE LLC 
1221 SOUTH VALLEY GROVE WAY 
VALLEY GROVE II | SUITE 500 
PLEASANT GROVE, UTAH 84062, U.S.A. 

www.SUSE.com 

Online Documentation: To access the online documentation for this and other SUSE products, 
and to get updates, see www.suse.com/documentation. 

 

https://www.suse.com/company/legal/
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Online SUSE Developer Services Program Guide Documentation: To access the online SUSE 
Developer Services Program Guide, see  

https://links.imagerelay.com/cdn/3404/ql/c0b0ca33142441b99c0e28f58d856629/suse-yes-
certification-program-guide.pdf 

Trademarks 
For a list of SUSE trademarks, see (http://www.suse.com/company/legal). 

All third-party trademarks are the property of their respective owners. 
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About This Guide 
The Server Yes Certification Test Kit for SUSE® Linux contains a procedure manual and all test 
tools necessary to test the SUSE® products used in the SUSE Yes Certified™ system 
certification process. The manual explains how to install the software and set up hardware 
and software configurations. 

 

Audience 

This manual is intended for users who have experience with computers, networking, Linux, and 
Microsoft Windows. 

 

Feedback 

We want to hear your comments and suggestions about this manual and the other 
documentation included with this product. Please contact your SUSE partner contact for 
feedback.  

 

Documentation Updates 

For the most recent version of the System Test Tools and documentation, visit System Test 
Tools for SUSE LINUX https://www.suse.com/partners/ihv/yes/system-test-tools-for-suse-
linux.html. 

 

Additional Information 

For more Information on YES Certification, see: 

SUSE YES Certified Program https://www.suse.com/partners/ihv/yes/ 

Partner Resources https://www.suse.com/partners/become-partner/ 

 

Documentation Conventions 

A trademark symbol (®, ™, etc.) denotes a SUSE trademark. An asterisk (*) denotes a third-
party trademark. 

 

 

 

 

 

https://www.suse.com/partners/become-partner/
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1 Setting Up TestConsole 
This document is to be used to set up TestConsole(TC).  The TestConsole is the controller for 
the YES Certification tests which will be exercised on the system which you will be testing.  
This document is intended for users with SUSE Linux experience, but all instructions are listed 
step by step and should be suitable for a novice SUSE Linux user.  Please follow all steps in 
the order which they are listed.    
  

Minimum Hardware Requirements for the TestConsole System (TC) 

✓ AMD 64 or Intel EM64T server class system (x86_64 architecture) system.   
(Problems with non-server-class TC systems may not be supported by SUSE).         
We DO NOT support ARM systems as the TestConsole(TC).   

✓ Direct access to the system under test (SUT). Do not use remote access, do not use 
SSH. 

✓ Server-class amounts of RAM and hard disk space (should be greater than OS 
supported minimums). 

✓ Serial Port and Null modem serial cable (required if testing SUT serial port). 

✓ 1 NIC ports or more depending on SUT, (NIC Speed must match the highest capable 
speed of the SUT NIC). 

✓ We recommend UEFI be enabled during testing if the SUT supports UEFI. 

✓ Secure Boot is not required to be enabled during testing, it is optional.  We 
recommend that Secure Boot is disabled on the TC during testing. 

 

1.1 Installing SLES 15 SP5 on TC 
This section will lead the user through the steps to install the OS onto the TC.  Estimated 
time to complete: 35 minutes.  15 of the minutes will be following the steps below.   The 
other 20 minutes is waiting for the OS to install onto the TC.  The estimated time does 
not include downloading and creating the OS USB bootable Thumb drive or deleting 
information from the existing partitions.   

1. Delete all existing partitions from all hard drives.  Please see the Troubleshooting 
and Help document, Section 1.1 “Removing the ELIO Boot Tables” for instructions 
which will delete any and all existing partitions.  If this step needs to be 
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completed, it can take up to 4 minutes. 
 

2. We recommend disabling Secure Boot in the hardware on the TC. 

3. Use a SLES system to create a SLE 15 SP5 bootable Installation thumb drive to be 
used to install SLES 15 SP5 onto the TC.  You will need at least a 16 GB thumb drive.  
The SLE 15 SP5 OS files will use about 12 GB of disk space on a hidden partition 
which is created on the thumbdrive.  The process may take minutes to complete. 

a. Make sure that the SLE 15 SP5 ISO Image is copied onto a SLES 12 SP5 or newer 
system hard drive. 

b. Plug the USB thumb drive into the SLES system from step 3.  

c. Open a terminal. 

d. Type dd if=PATH_TO_SLE_15_SP5_ISO_IMAGE of=USB_STORAGE_DEVICE 
bs=4M.   Example:                                                                                                                 
dd if=/tmp/SLE-15-SP5-Full-x86_64-GM-Media1.iso of=/dev/sdb bs=20M.   

e. After the bootable thumb drive creation is completed, unmount and remove 
the USB thumb drive. 

4. Plug the SLE 15 SP5 bootable installation thumb drive into your TC.  

5. Boot your TC to the SLES 15 SP5 bootable installation thumb drive. 

6. Select Installation <Enter> before the 20 second timeout expires. 

7. Select the English (US) Language. 

8. Select the English (US) Keyboard Layout. 

9. Click on SUSE Linux Enterprise Server 15 SP5, then click Next.  

10. Select I Agree to the license terms, then click Next. 

11. Click on the Hostname/DNS tab in the Network Settings screen.  You may need to  
be on a secluded network to see this tab screen.  

12. Edit the Static Hostname to be TC.  No spaces allowed in the hostname. 

13. Click on the Overview Tab in the Network Settings screen. 

14. Configure the Network Settings. 

a. Click on a Network Adapter (NIC) in the Name list window.  It is recommended to 
start with the eth0 NIC. 
 

b. Click Edit. 
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c. If not already selected, click the statically assigned IP Address radio button.  
Below is a table displaying the TC NIC ports associated IP addresses and the 
relationship to the SUT NIC ports. The table provides the big picture for 
configuring the test environment. The TC must be configured to 
accommodate the NIC ports in the SUT.  The TC can have as many physical 
NIC port’s as needed to have up to a 1 to 1 NIC port to correlate to the SUT.  Alias 
IP addresses can also be on the TC used when the TC does not have enough NIC 
ports to match the SUT.  Refer to Table 1-1 for IP address configuration pattern. 
 

   Table 1-1 TC and SUT IP Address Mapping 

 

 

d. Enter a permanent Static IP address for the TC NIC (refer to Table 1-1) into 
the IP Address field. 

e. Enter 255.255.255.0 for the Subnet mask. 

f. Click Next to return to the Network Settings window. 

g. If prompted click Yes at the blank hostname question.  

15. Repeat step 14 for each NIC as needed.  Note:  If the SUT has more NICs then the TC, 
configure the virtual IP addresses (aliases) on the TC (up to 3 alias IP addresses per 
NIC port spaced evenly across NIC cards).  If the SUT has a wireless NIC and TC has 
only 2 NIC’s then alias the TC wireless NIC IP address (10.1.3.2) to 10.1.2.2 on the TC.  
Refer to the Troubleshooting section in this document for detailed information on 
setting up the alias IP Addresses. 
 

16. Click Next in the Network Settings window. 

TC 
NIC 

TC IP 
Address 

Notes Switch SUT 
NIC 

SUT IP 
Address 

Notes 

ETH 0 10.1.1.2 NIC 1 1 ETH 0 10.1.1.1 NIC 1 

ETH 1 10.1.2.2 NIC 2 2 ETH 1 10.1.2.1 NIC 2 

ETH 2 10.1.3.2  
WiFi 

NIC 3  3 ETH 2 10.1.3.1  
WiFi 

NIC 3  

ETH 3 10.1.4.2 NIC 4 4 ETH 3 10.1.4.1 NIC 4 
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17. Click the Skip Registration radio button on the Registration screen. 

a. Click OK in the Skipping Registration warning message prompt. 

b. Click Next. 

18. On the Available Extensions and Modules screen select the following: 

✓ Basesystem Module 

✓ Desktop Application Module 

✓ Development Tools Module 

✓ Server Application Module 

✓ SUSE Linux Enterprise Workstation Extensions 15 SP5 (this is for the hard drive and 

thumb drive, etc. ntfs accessibility). 

a. Click Next. 

19. If prompted, click Next in the Add On Product Installation screen. 

20. Click on SLES with Gnome on the System Role screen then click Next. 

21. Click Next at the Suggested Partitioning screen.   

22. Adjust the region and time zone to match your region and time zone. 

a. Click your region in the Region pull down menu on the left side or click on your 
time zone in the map. 
 

b. Click your time zone in the Time Zone pull down menu on the right side or click 
on your time zone in the map.  

 
23. Set the system clock.  We require that the system clock be set to match the time 

of the other systems in the test harness (TC and SUT). Having logs with accurate 
time stamps set to the same time will greatly help troubleshooting. 

a. Click the Other Settings button. 

b. Change the Current time and Current date to be accurate. 

c. Click the Accept button. 

24. Click the Next button to complete the setup of the Clock and Time Zone screen. 

25. Configure the Local User. 

a. Click the Skip User Creation radio button. 

b. Click Next in the Local User screen. 
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26. Set the password for the System Administrator root. 

a. Type a password (E.g., suse) into both fields for the root user password. 

b. Click Next. 

c. Click Yes to the Really use the password at the password is too simple prompt. 

27. Disable the firewall by clicking on disable next to firewall will be enabled. The 
display will change to firewall will be disabled. 

28. If listed as disabled, enable the SSH service by clicking on enable next to SSH service 
will be disabled. The display will change to SSH service will be enabled.  

29. If listed, enable an SSH port by clicking on open next to SSH port will be blocked. The 
display will change to SSH port will be open. 

30. Click Install to start the installation. 

31. Click Install in the popup window to confirm the installation. 

32. After the installation is complete, leave the existing SLES 15 SP5 bootable USB 
thumb drive in the TC. 

33. Reboot the TC then go to Section 1.2 “Installing the Test Kit on TC”. 

 

1.2 Installing the Test Kit on TC 
This section will walk through installing the test kit onto the TC system.   
Estimated time to completion: 20 minutes.  5 of the 20 minutes is a wait time in the  
middle of the install. 

 
1. Log into the TC as root. 

a. On the password screen click on the gear/cog button on the bottom right. 

b. Click on GNOME Classic. 

c. Type in the root password, then press <Enter>.   Use the password (i.e, suse) 
created during the TC OS installation.   

2. Ensure that the SLES 15 SP5 bootable USB thumb drive is in the system. 

3. Open a terminal window by clicking on the top left Application -> Utilities -> 
Terminal. 

a. In the terminal window type yast2 repositories <Enter>. 
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b. In the Configured Software Repositories screen click on a software Repository 
entry (Example SLES15-SP5-15.5-0). 

c. Click on the Enabled checkbox in the bottom left side of the Configured 
Software Repositories screen.  A checkmark will appear next to the software 
repository under the enable category.  

d. Repeat steps b and c for each Software Repository entry listed until each 
Software Repository is enabled. 

e. Click the OK button in the bottom right side of the Configured Software 
Repositories screen. 

4. Copy the SLES 15 SP5 ISO image onto the TC. 

5. Download the latest SUSE Yes Certification Test Kit iso file onto your personal 
workstation.  

6. Transfer the SUSE Yes Certification Test Kit iso file onto a USB storage device. 

7. Copy the SUSE Yes Certification Test Kit iso file onto the TC desktop from the USB 
storage device.  

8. Safely Remove the USB storage device which contains the SUSE Yes Certification 
Test Kit from the TC. 

9. Create a directory which will be used for a SUSE Yes Certification test kit mount 
point (example: /root/Desktop/sck/ ). 

10. Open a terminal window by clicking on the top left Application -> Utilities -> 
Terminal. 

a. In the terminal window type: cd /root/Desktop <Enter>. 

b. In the terminal window type: md sck <Enter>. 

11. Mount the test kit ISO image on the TC by typing the following in a terminal 
window:  mount /<Path>/<Test kit file name.iso> /root/Desktop/sck/ <Enter>. 

Example: mount /root/Desktop/suse-systest-8.8-GM.iso /root/Desktop/sck/ 
<Enter> 

12. Start the test kit install by typing the following in a terminal window: 
/root/Desktop/sck/sck_install.sh <Enter>.  
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13. Type in the first IP Address of the TC. 

14. Choose 3 to install the Test Kit for TC, then press <Enter>. 

15. When prompted type the TC's IP address (default IP address = 10.1.1.2), then press 
<Enter>. 

16. If prompted type in the password for the TC (E.g., suse), then press <Enter>. 

17. When prompted type yes <Enter> to continue connecting.  

18. Type in the TC root password when prompted. 

19. Type the password suse <Enter> at the New SMB password (Samba) prompt.   

Note: No characters or asterisks will be displayed when typing the Samba 
password. 

20. Type the New SMB password, suse, again then press <Enter>. 

Note: The default username is set to root by the Test Kit. If the password is not 
typed the same during each SMB password entry the message: “Error 
smbconfig.sh” may be displayed. 

21. It is recommended that you answer Y <Enter> to the TC DHCP and PXE server 
question.  Otherwise, we cannot support your SLE installation server.  There is 
information in the troubleshooting documentation for setting up a SLE 15 SP1 
installation server.   

22. Select the NIC with the IP address 10.1.1.2 for the DHCP configuration then press 
<Enter>. The NIC must be on an isolated network. 

23. Confirm the NIC which you have selected by answering the “use ethx, is this 
correct?” question by typing Y <Enter>. 

24. To change the DHCP Address range follow the steps below, otherwise type: N <enter> 
at the prompt. 

a. At the prompt: “Do you want to change the DHCP available address range?” 
type: Y <enter>. 

b. Complete the beginning IP address for the new range then press enter. 

c. Complete the ending IP address for the new range then press enter.  A 
message will be displayed in the terminal window stating that the DHCP 
server is restarting. 
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25. Type q <Enter> in response to the question “Would you like to add or remove ISO's” 

to the PXE boot install menu question.  This will be configured later. 

26. When prompted, press <Enter> to exit the Test Kit install script.  If the IP address of 
the TC is changed after this point, then the Test Kit must be re-installed. 

27. Safely remove the SLES 15 SP5 bootable USB thumb drive.   

28. Continue to Section 2. 
 

2 Setting Up PXE Menu on TC 
Starting with System Test Kit 7 the TestConsole (TC) system can function as a DHCP and PXE 
install server. The basic DHCP and PXE functionality is enabled during the TC system Test Kit 
installation.   Once you have downloaded the OS ISO images, they need to be copied onto 
the TC.  If you will be copying the OS ISO images from a windows desktop then format the 
USB device to NTFS so that it can read by both windows and Linux.  The estimated time to 
copy the OS from the USB device to the TC is 8 minutes per OS.  The time needed to 
download the OS from the SUSE website depends on your internet speed.  

 

2.1 Copy SLE ISO images to TC  

 

1. Download the desired SLE ISO image(s) from https://download.suse.com/index.jsp  
 

2. Alternately, you can create the ISO image directly from an installation DVD using 
the dd command. 

Example: dd if=/dev/sr0 of=./SLES-12-SP5-x86_64.iso bs=4k <Enter>. 

3. If you need to use a KISO then see the section entitled Adding KISO to PXE Menu in 
the back of this document.  
 

4. Transfer the downloaded SLE ISO file(s) to a storage device.  

https://download.suse.com/index.jsp
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Note: If transfers are made from a windows system to a SLES system then the 
storage device will need to be formatted as an NTFS file system to 
accommodate large OS ISO file sizes.  

5. Create a folder on TC where you will keep the SLE ISO images.  The folder name 
must not have any spaces in the name.  

6. Copy the SLE ISO images into this folder on the TC.  

7. After copying the files, unmount and remove the USB Storage device which the ISO 
images were copied from. 

8. Continue to Section 2.2 “Add SLE ISO images to PXE menu on TC”. 

2.2 Add SLE ISO Images to PXE Menu on TC  

This section will populate the PXE menu OS’s to choose from in the PXE menu for a PXE boot 
OS installation.  The estimated time to completion is 3 minutes. 

 
1. On the TC open a terminal, then type: 

/opt/suse/testKits/system/bin/configinstserver.sh <Enter>. 

2. Type Y <Enter> when prompted with the question “would you like to add or remove 

ISO’s?”. 

3. Type A <Enter> to add an image. The configinstserver.sh script will search for and 
display all ISO images on the system. 

Note: This PXE server configuration is set up for SLE products only.  Do not add ISO images for 
operating systems other than SLE products, even though the search will find other 
ISO's. 

4. Enter the number of the ISO image to be added.   
 

5. Repeat steps 3 & 4 for each additional SLE ISO image to be added to the PXE install 
menu, then press <Enter>. 

Note: Up to 8 ISO images can be added to the TC PXE server. 
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6. Type Q <Enter> to exit the configinstserver.sh program.  

7. Unmount SCK ISO. 

8. Continue to Section 3. 

 
 
 

3 Update Products.txt and Verify TCLINK 

3.1 Update Products.txt File 
The products.txt file updates the TC with the latest hardware components available from 
the SBS database. This makes them available for selection when entering the SUT system 
information.  The estimated time to complete the manual products.txt update is 5 
minutes. 

 
1. Download the latest products.zip from the YES System Test Tools for SUSE Linux 

webpage at: 
https://www.suse.com/partners/ihv/yes/system-test-tools-for-suse-linux.html 

2. Copy the products.zip file to a USB storage device. 

3. On TC, open TestConsole by clicking on the top left Applications-> Programming-> 
TestConsole icon.  The icon may appear as the icon on the left below until after 
the first launch of TestConsole. 

 
4. If prompted click Trust and Launch. 

5. Insert the USB storage device containing the latest products.zip file into the TC 
system. 

6. The Select products.txt zip file window should appear in TestConsole.  If the Select 
products.txt zip file window and the Products.txt Update Help window is not 
displayed, then click Console > Update Products.txt from the menu bar. 

 
 
 

https://www.suse.com/partners/ihv/yes/system-test-tools-for-suse-linux.html
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7. In the Select Products.zip file window click the down arrow (↓) next to Look in: . 

8. Select the / character. 

9. Double-click on run. 

10. Double-click on media. 

11. If root is listed, then double-click on root. 

12. Double-click on the removable storage device containing the products.zip file. 

13. Click on the Products.zip file. 

14. Click Save. 

15. Click OK at the Products.txt Update Help window. 

16. Close Test Console by clicking on the “x” in the upper right corner.   

17. Click Yes to really quit. 

18. Unmount and remove the removable storage device. 
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19. Open Test Console by clicking the Test Console icon located on the TC desktop. 
 
The product.txt update is now complete. Ensure that the Test Console screen is in 
full screen mode so that the date and time information for the products.txt file will 
be displayed in the bottom of the Test Console window. 

Notes: The Products.txt file can also be updated directly via an Internet connection 
from the TC. We recommend the Products.txt file be updated on a regular basis 
before testing begins. 

20. Continue to Section 3.2 “Verify TCLINK IP Address”. 
 
 
 

3.2 Verify TCLINK IP Address 

1. Verify that the TCLINK window displays the IP address of the first network adapter 
on TC (ex. 10.1.1.2).  The small TCLINK window may be hidden behind the 
TestConsole screen.  

 

 
 

2. If the IP address does not match the primary TC network adapter, perform the 
following steps: 

a. Open a terminal window. 

b. In the terminal window type: gedit /etc/hosts <Enter>. 

c. Edit the IP address next to TC or TC.suse TC to match the IP address of the 
primary TC network adapter (example: 10.1.1.2   TC  or 10.1.1.2   TC.suse TC). 

d. Click on the save button in the top right side.  
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e. Close gedit by clicking on the x button located at the top right.  

f. Close TestConsole. 

g. Open Test Console by clicking the Test Console icon located on the TC desktop.  

h. The correct IP address should now be shown in TCLINK. 

3. Proceed to the next Test kit document for the OS installation and testing.   This will 
be the document for the OS which you plan to install and test.  An example would 
be the SLES document or the SLED document.  Some of the document’s names are 
Server_Extended_SCK_...-<date> and Workstation_and_Laptop_...-<date>. Keep in 
mind that SLES will need to be installed before the KVM or XEN can be installed.  If 
you are planning to install and test XEN or KVM and have a windows guest, then go 
to section 4.   
 

4 Set up TC for Windows VM Testing 

  If you will be testing KVM or XEN with a Window guest then the SUSE Virtual Machine Driver 
Pack(VMDP) will be needed.  The SUSE VMDP information webpage is 
https://www.suse.com/products/vmdriverpack/ .  The download site for the SUSE VMDP is 

https://www.suse.com/download/suse-vmdp/ .  To install and configure the VMDP perform the 
following steps: 

1. Open a Terminal. 
2. Type “cd /opt/suse/testKits” <Enter>. 

3. Place the Virtual Machine Driver Pack (VMDP-WIN-*.*.*.exe) file in the /testKits folder.  
A real example filename is VMDP-WIN-2.5.3.exe.  

Note: Log into your SUSE Customer Center (SCC) account to access and download 
the Virtual Machine Driver Pack (VMDP).  If the latest VMDP is not available, or you 
encounter issues then contact your SUSE Partner Engineering representative.   

4. Create a separate folder with a unique name (ex. Win-ISO). 

5. Place any Windows ISO files there. 

6. Place a Windows laptop or PC on the same network as TC.  TC is set up as a DHCP 
server and should serve an appropriate IP address. 

 
7. Click the File icon on the bottom left of the Windows PC. 

https://www.suse.com/products/vmdriverpack/
https://www.suse.com/download/suse-vmdp/
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8. Right-click Network, then choose Map Network Drive.  

9. Select Drive T: from the dropdown window. 

10. Type “\\10.1.1.2\windir\” 

11. Click Finish. 

12. Enter the TC username (root) and password (suse) and click OK. 

13. Double-click to open the testKits folder. 

14. Double-click VMDP-WIN-*.*.exe (e.g. VMDP-WIN-2.5.3.exe) 

15. The directory created by the self-extracting executable is VMDP-WIN-#.#.#/  (e.g. 

VMDP-WIN-2.5.3/). 

Note: This will create a VMDP-Win directory in the test Kits folder that contains the 
VM Driver Pack installation files used in testing.    

16. Proceed to the next Test kit document for the OS installation.   This will be the 
document for the OS which you plan to install and test.  An example would be the 
SLES document or the SLED document.  Keep in mind that SLES will need to be 
installed before the KVM or XEN can be installed. 
 

5 Dealing with Unused NIC ports on the TC 

If you have a NIC port on the TC which is not being used on the test network/s but the NIC 
port has an IP Address, then the IP Address will need to be added to the “do not test” file. 
 
To add the NIC Port IP Address to the do not test file, do the following: 
echo <IP_Address>  >> /opt/suse/testKits/system/configs/do_not_test 
 
Example: echo 137.65.80.10 >> /opt/suse/testKits/system/configs/do_not_test 
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6 Using TestConsole 

The TestConsole main window displays three distinct panes: Project Contents, Run Queue, 
and Project Log. You may display these panes in tiled or tabbed formats. You can change 
the display in the View menu. We recommend the tabbed view if your monitor has a lower 
than 1024x768 resolution. Each open test project is displayed on its own tab and can be 
quickly accessed by clicking on the tab with the test project name. 

 
 

6.1 Project Contents 

The Project Contents pane uses an expanding tree format to display the tests 
associated with the project you have chosen. For example, to expand or collapse a 
group of tests, click the plus or minus icons next to the test. There are three columns in 
the Project Contents pane. The first column displays the title of the test. The second 
column indicates whether the test is selected to be run with a test group (blank box = 
unselected, check mark in box = selected). The third column indicates the final test 
result (untested, pass, fail, etc.). The Project Contents pane may also display a Station 
Address icon (computer icon) to enable you to select your test station. 
 

6.2 Starting Tests 

1. Double-click any item in the Project Contents pane and the test will start. 

2. Right-click any item in the Project Contents pane and choose an item from the 
popup menu to view properties. 

3. TestConsole saves project files once a test has stopped. This includes product 
information and test results. 

Note: To select or de-select a test, click the boxes in the second column. A check 
mark in the column indicates you have selected the test.      
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6.3 Run Queue 

The Run Queue pane displays the tests that are currently running or queued to start. It 
displays the test name, the status and the IP address of the test station. The Cancel Test 
button enables you to cancel the highlighted test that is in the Run Queue. The Cancel 
All button cancels all tests that are queued to run. The Remove Test button allows you to 
remove a test, even if it is hung. 

Note: When a test is running, the word “running” appears in the status column. If the 
station under test loses its connection the status column will show two computers 
disconnected. 

 

6.4 Project Log 

The Project Log pane displays a running log of the tests in your test project. It records the 
time each test started and finished, the result of the test, and other pertinent 
information. To display additional information about the test, errors, warnings, and 
failures in the Project Log pane, run the test in debug mode. 

 

6.5 TestConsole Testing Modes 

TestConsole can be run in additional testing modes which are not typically used during 
the certification testing. This section (C.5) will provide information for the different 
modes. 

 

6.6 Debug Mode 

Debug Mode displays additional information about errors and failures encountered 
while running the test. This information is displayed in the Event Log pane of the 
TestConsole window. Not all test modules support the logging of debug information. To 
enable debug mode, click the Debug check box in the Event Log control bar. Debug 
mode runs slower than the normal test mode and can quickly fill up the event log. By 
default, the log is limited to 10,000 entries. When it exceeds 10,000, the entries at the 
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beginning of the log are lost. 

6.7 Loop Mode 

Loop mode allows you to set up a list of tests or test groups in any order and to run the 
tests for a multiple number of times in a loop. You can specify loop counts for individual 
tests as well as groups of tests. 
 
Editing the Loop Test List 
To create or edit the Loop Test List, from the menu bar select Loop > Edit Loop List. This will 
display a dialog box with two panels. The left panel displays the available Project 
Contents. The right panel displays the Loop Test List. 
 
In the Project Contents panel, select the test or group that you want to add to the Loop 
Test List and click Add. The selected items will be added to the loop list. You can continue 
to add items in any order. 
 
To delete a test or group, select the item in the Loop Test List panel and click Remove. 
To rearrange the order of the tests within a group, right-click the item in the Loop Test List 
panel and select Move Up or Move Down from the popup menu. 
 
To edit the loop count for individual tests or test groups, either double-click the Loop 
Count column next to the test title or right-click the test title and select Loop Count. This 
displays a dialog that allows you to edit the loop count properties. The Loop Test List will 
be saved until the project is closed. You can close the Loop dialog at any time. 
 
Starting the Loop Test List 
If the Loop List dialog window is open, click Run List. 
If the Loop List dialog window is closed, from the menu bar click Loop> Run Loop List. 

Note: Currently, loop mode restricts the number of test instances that can be placed on 
the Run Queue to 100 maximum. For example, if you have 2 tests in a group that run 25 
times each with the group itself running 2 times, then you have reached your maximum. 

Choose tests to run 
Choose the test to be enabled. 
Double-click Enable . . . Testing to enable the test. 
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6.8 Importing Product Information from an 
Existing Project   

You may import product information from an old project into a new project.  
TestConsole will only import the product information.  TestConsole will not import test 
results.  Importing product information will delete all test results of the current project.  
Import product information before you perform any tests. 

 

1. Start TestConsole. 

a. Turn on the TC and log in as root. 

b. Double-click the TestConsole icon on the desktop. 

2. Open the Project. 

a. Click Project > Open Test Project > New. 

b. Select (Server or Client) - Full or (Server or Client) - Reduced and click Select. 

c. Click Yes at the Warning! window to enter the SUT product information now. 

3. Import the project. 

a. Click File > Import Product File. 

b. Click Yes at the Warning! Window. 

c. Browse for the project file to be imported in the 
/opt/suse/testKits/System/status directory (e.g., YourFile.TSF). 

d. Remove all drivers and adapters listed in the video, LAN, and HBA tabs. 

e. Click OK in the Product & Report Information window. 

4. Save the project. 

a. Click Project > Save Test Project As. 

b. Replace the project name with a unique name (e.g., P2System). 

c. Click Save. 

Note: TestConsole will import all of the product information into the current 
project, and it will reset all test results. Remember to change all pertinent 
information before starting any tests. 
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d. Make any necessary changes in the product information. 

e. Click OK. 
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7 Troubleshooting 

7.1 TC Connection    

You can test the connection to tclink by starting the tclink with the debug argument 
(tclink debug). Then you can telnet from any system to that tclink (e.g., telnet 10.1.1.1 
7078). If there is a live connection, the linux tclink should display some information on 
the screen as a result of the telnet. On linux, tclink communicates via the 7078 port. On 
Java, tclink communicates via port 7076 but doesn’t print anything. 

 
 

7.2 TestConsole Locks UP/Blank Screen during 

Testing    

If TestConsole locks up or has a blank screen during testing, the following is advised: 
 

1. TestConsole may be busy. Wait 10 minutes for the TestConsole window to be 

redrawn.  

2. Click on the TC Terminal window. Then click on the TestConsole window. 

3. Check for message screens hidden behind other screens. A message screen may 
be hidden and be waiting to have the OK button clicked on before the TestConsole 
screen will be displayed correctly. 

 

7.3 TestConsole displays Error Attempting to Run 

Test    

If “Error attempting to run test” appears on the TestConsole log screen, check /var/opt/ 
suse/TestKits/ for log files.   If you deleted the icon on the desktop for TestConsole; you 
probably cannot get the icon to reappear on the desktop by reinstalling the Test Kit. The 
way to get the desktop icon back is to remove the /root/.skel/tc.icon file, log out and log 
back into TestConsole. 
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7.4 Error Messages    

Error messages will occur for a variety of reasons (e.g., incomplete required information 
or test results). Error messages indicate problems with required tests or product 
information. All required tests must be completed or have a valid exception approved 
by SUSE in order to receive a bulletin. TestConsole will produce an error message for 
each required test that does not pass or have test results. These tests must be 
completed (or have a valid exception) in order to receive a bulletin. TestConsole will 
also generate an error message for each required empty field in the Product and 
Reporting Information screen forms. Each required field must be completely filled in to 
receive a bulletin. 

Note: Any changes to fields in the System tab (except the Product Description field) will 
reset all test results for the product. Contact a SUSE Engineer if changes must be made 
to these fields. 

 

7.5 Warning Messages 

Warning messages also occur for a variety of reasons (e.g., incomplete optional 
information or test results). TestConsole will generate a warning message for each 
optional test that does not have test results. 
 
If you receive a Error message that TC cannot ping 10.1.1.2, make sure that TC is on an 
isolated switch and on an isolated network. 

 

 
 
 

7.6 Manual Test Kit Uninstall 

The Test Kit may also be uninstalled from TC by following the steps below.  

1. Open a terminal. 
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2. Type rpm -e sck-tc <Enter>. 

3. Type rpm -e tconsole <Enter>. 

4. Type rpm -e tclink <Enter>. 

5. Type rpm -e sck-common <Enter>. 

6. All remaining files will also need to be removed by doing the following: 

a. At the shell prompt, type rm -r /var/opt/suse/testKits 

b. At the shell prompt, type rm -r /opt/suse/testKits 
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8 Setting Up NIC Aliases 

1. If the SUT has 5 or more NICs and the TC does not have enough NIC ports the 
example in the table below can be used an example to set up and configure 
virtual IP addresses (aliases) on the TC. 
a. Based on the IP addresses in the Table below choose the appropriate IP 

address to configure. 
b. On TC, open a terminal. 
c. In the terminal type yast2 lan <Enter>.   
d. Click on the appropriate NIC. 
e. Click on Edit. 
f. Click on Add. 
g. Type your own label name into the IPv4 Address Label name field.  Example 

names are IPAlias or WiFiAlias.  No spaces are allowed in the IPv4 Address Label 
name.  

h. Using the table below enter the alias IP Address into IP Address Field. 

Note: If you are using different IP addresses than those listed below, write in the 
actual IP address used in the IP address column. 

              TC Alias Name     eth number             IP Address                    Notes 
 

 
TC5 

 
eth0 

 
10.1.5.2 

 
Alias on NIC 1 

 
If the SUT has 5 NICs 

TC6 eth1 10.1.6.2 Alias on NIC 2 If the SUT has 6 NICs 

TC7 eth2 10.1.7.2 Alias on NIC 3 If the SUT has 7 NICs 
TC8 eth3 10.1.8.2 Alias on NIC 4 If the SUT has 8 NICs 
TC9 eth0 10.1.9.2 Alias on NIC 1 If the SUT has 9 NICs 
TC10 eth1 10.1.10.2 Alias on NIC 2 If the SUT has 10 NICs 

ports TC11 eth2 10.1.11.2 Alias on NIC 3 If the SUT has 11 NICs 
ports TC12 eth3 10.1.12.2 Alias on NIC 4 If the SUT has 12 NICs 
ports TC13 eth0 10.1.13.2 Alias on NIC 1 If the SUT has 13 NICs 
ports TC14 eth1 10.1.14.2 Alias on NIC 2 If the SUT has 14 NICs 
ports TC15 eth2 10.1.15.2 Alias on NIC 3 If the SUT has 15 NICs 
ports TC16 eth3 10.1.16.2                  Alias on NIC 4    If the SUT has 16 NICs 

 

i. Enter 255.255.255.0 for the Netmask. 
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j. Click OK. 

k. Repeat d - g for each additional virtual IP address (Alias) needed for this TC NIC. 

l. Click Next in the Network card setup window. 

m. Click Yes for the blank hostname question.  

2. Repeat 1a-1m for each additional virtual IP address needed for this TC NIC. 
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9 Adding KISO to PXE Menu 

You can only install a kISO file using the Manual PXE option. 

9.1 Adding a SLE 12 KISO 

1. Rename the KISO image (prior to adding the ISO) using the following convention:  
<OS_Ven>-<OS_Ver>-<SP>-<Media_Type>-<Arch>-<Build>-<Media#>-
<Custom>.iso  

OS_Ven = OS Vendor: Use default value: SLE 
OS_Ver = OS Version: Use default value: 12 
SP = Service Pack: Use default value: SP5  
Media_Type = Must Use: KISO 
Arch = Architecture: Use default value: x86_64, aarch64, ppc64le, or s390x 
Build = Use default value: GM, GMC, BETA1, etc  
Media# = Use default value: Media1 
Custom = Custom Information (optional): Any string to uniquely identify the iso.  

Note: This custom information can also be used to match the KISO with a custom 
autoyast file. 

Examples: 
Original Installation ISO for SLE 12 SP5 for x86_64: 
SLE-12-SP5-Server-x86_64-GM-Media1.iso  

Sample KISO for SLE 12 SP5 for x86_64: 
SLE-12-SP5-KISO-x86_64-GM-Media1-<optional_custom_info>.iso  

2. If a KISO file is found on TC during PXE Menu setup (configinstserver.sh) the 
following prompt displays: 
Do you want to add the KISO (SLE-12-SP5-KISO-x86_64-GM-Media1-
<custom_info>.iso) to the PXE boot (N/y)?  

a. Answer "y" (yes) to add the KISO file to the PXE Menu. 

Note: This will cause the installation to use the KISO during the install of any SLE 
12 x86_64 system. 
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b. Answer “n” (no) to ignore the KISO file and use the original installation ISO. 

3. To remove a KISO file from the PXE Menu, perform the following steps: 

a. Remove the SLE 12 x86_64 installation ISO from the PXE boot list (using 

configinstserver.sh)  

b. Re-add the SLE 12 x86_64 installation ISO answering "N" (No) when prompted to 

add the KISO. 

 

9.2 Adding a SLE 15 KISO 

1. Rename the KISO image (prior to adding the ISO) using the following convention:  
<OS_Ven>-<OS_Ver>-<SP>-<Media_Type>-<Arch>-<Build>-<Media#>-
<Custom>.iso  

OS_Ven = OS Vendor: Use default value: SLE 
OS_Ver = OS Version: Use default value: 15 
SP = Service Pack: Use default value: SP2 or SP3  
Media_Type = Use Default value: Installer-DVD 
Arch = Architecture: Use default value: x86_64, aarch64, ppc64le, or s390x 
Build = Use default value: GM, GMC, BETA1, etc   

Media# = Use default value: DVD1 
Custom = Custom Information (optional): Any string to uniquely identify the iso.  

Note: This custom information can also be used to match the KISO with a custom 
autoyast file. 

Examples: 
Original Installation ISO for SLE 15 SP5 for x86_64: 
SLE-15-SP5-Full-x86_64-GM-Media1.iso 

Sample KISO for SLE 15 SP5 for x86_64: 
SLE-15-SP5-Media1-x86_64-GM-DVD1-<optional_custom_info>.iso  

2. If an additional SLE 15 KISO file is found on TC during PXE Menu setup 
(configinstserver.sh) the following prompt displays:  

Do you want to add the KISO (SLE-15-SP5-KISO-x86_64-GM-Media1-
<custom_info>.iso) to the PXE boot (N/y)?  

a. Answer “n” (no) to ignore the additional KISO file and use the renamed KISO file. 
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Note: This step will cause the installation to use the KISO during the install of 
any SLE 15 x86_64 system. 

3. To remove a KISO file from the PXE Menu, perform the following steps: 

a. Remove the SLE 15 x86_64 installation ISO from the PXE boot list (using 
configinstserver.sh)  

b. Re-add the SLE 15 x86_64 installation ISO answering "N" (No) when prompted to 
add the KISO. 
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